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Preface
The CATIA Version 5 Circuit Board Design is a new generation product which
addresses circuit board design in a mechanical design context and interfaces with
external ECAD systems.
The CATIA - Circuit Board Design offers the following main functions:
Data can be imported from ECAD Systems through IDF Files
Data can be exported to ECAD Systems through IDF Files
Circuit board geometry is designed within the global assembly product definition
taking into account the mechanical context
Electronic properties such as top and bottom faces can be defined and edited
on any parts and assemblies
Spatial and technological constraint areas can be created and managed
Circuit board definitions can be analyzed in the context of the full Digital
Mock-Up definition
Creation and management of electronic part catalogs are available
As a scalable product, CATIA Version 5 Circuit Board Design can be used in
cooperation with other current or future companion products of the next CATIA
generation such as CATIA Version 5 Assembly Design and ENOVIA-DMU Navigator
Version 5.

Where to Find More Information
Prior to reading this book, we recommend that you read the CATIA - Infrastructure
User's Guide.
The CATIA - Part Design User's Guide, the CATIA - Assembly Design User's Guide
and the CATIA - Sketcher Version 5 may prove useful.

What's New?
New

Creating Components

Enhanced
New

Component Properties
Creating a Catalog

New

Query from Catalog

New

Import using a Catalog

New

Import in Context

Getting Started
Before getting into the detailed instructions for using CATIA - Circuit Board Design Version 5, the following tutorial
provides a step-by-step scenario demonstrating how to use key functionalities.

Before starting this scenario, you should be familiar with the basic commands common to all workbenches. These
are described in the CATIA - Infrastructure User's Guide.
The main tasks proposed in this section are:
Tasks

All together, these tasks should take about 15 minutes to complete.

Accessing the Circuit Board Workbench
in an Assembly Context
This task explains how to set up the environment to design in context.
To design in context, you need to load the CATProduct document containing the context; in this
case the bottom part of a CD player.
Open the CDPlayer.CATProduct document from the \online\samples\circuitboard directory.

Make sure the Product1 feature is highlighted before changing workbench.
1. Choose the Circuit Board Design item from the Start ->
Equipments & Systems menu.
The Circuit Board Design workbench is displayed and ready to use.

Note that a new part Part9 has been automatically added to the specification tree. It will be used to
design the board.

You can add the Circuit Board Design workbench to your Favorites, using the Tools ->
item. For more information, refer to CATIA V5 - Infrastructure User's Guide.

Customize

Creating a Board
This task explains how to create a board then design its geometry.
Circuit Board Design functions are available when you are in the Part Design environment.
Several functions are integrated from the Part Design workbench.
You are in the CDPlayer.CATProduct document.
The Circuit Board Design workbench is displayed.
1. Select the Board icon

.

2. Select the Sketcher icon

.

3. Select the bottom plane of the CD box.
The Sketcher workbench is launched.
4. Click the Profile icon

.

5. Sketch the contour of the Board.
The profile looks like this:

6. Quit the Sketcher using the Exit icon
You are now in the Circuit Board Design
workbench.

:

For more information about the Sketcher, refer to the CATIA V5 - Sketcher User's Guide.

7. Click the Pad icon

.

The Pad Definition dialog box appears.

8. Enter 2mm in the Length field.

9. Click OK.
The pad turns green, this means the board has been created.
The board has been created from the active part: Part9(BOARD)

CATIA recognizes the first pad created as the Board.

Creating a Pocket and Holes
This task shows how to create a pocket and two holes, with technological
properties.
1. Sketch the contour of the pocket.
To do so:
click the
Sketcher
icon
select the
board to
define the
working
plane
click the
Profile icon
and
draw the
contour
around the
motor
then click the
Exit Sketcher
to
icon
return to the
3D world.
2. Click the Pocket icon
.
The Pocket Definition dialog box is displayed and CATIA previews a
pocket with default parameters.

3. Set the Up to last
option to define the
pocket limit.
This means that the
application will extend the
pocket to the last
possible face, that is the
pad bottom.

4. Click OK.

5. Click the Hole icon

.

6. Select the board to define the working plane.
The Hole Definition dialog box appears.
CATIA previews the hole to be created with default parameters.
7. Enter 4mm for the diameter and click OK.
The hole is created.
8. Repeat the steps 5, 6 and 7 for the second hole.
The pocket and holes are added to the specification tree.

9. Right-click the Hole.1 in the specification tree to display the contextual menu.
10. Select Properties.
The Properties dialog box
opens.
11. Click the More... button.

12. Select the Circuit Board
tab.

13. Switch the Subtype to NPTH (non conductive) and click OK.
The hole is more than a simple hole: it has a technological property.

14. Repeat the steps 9 to 13 for the second hole.
These holes are used for mounting purposes.

Creating a Constraint Area
This task shows you how to create a constraint area.
A constraint area is a space reservation used for different purposes such as
allowing/forbidding the routing or placing of components etc.
Each constraint area belongs to a part, this is to say that you need to create a new part
before creating a constraint area.
Create a new part in your CDPlayer.CATProduct document.
To do so:
Double-click Product1 in the specification tree
Right-click the Product1 feature and select New Part in the contextual menu
Enter ConstArea for the Part Number and click OK
Click No to define the origin point of the assembly as the new part origin point.
1. Select the Constraint Area icon
.
The Constraint Areas dialog box opens.
The constraint area types are:
ROUTE_OUTLINE
PLACE_OUTLINE
OTHER_OUTLINE
VIA_KEEPOUT
PLACE_KEEPOUT
PLACE_REGION
ROUTE_KEEPOUT
2. Choose the PLACE_KEEPOUT type and click OK.
3. Select the Sketcher icon

.

4. Select the board to define the working plane.
5. Click the Profile icon

and draw the contour around the CD buttons.

6. Click the Exit Sketcher icon

7. Click the Pad icon

to return to the 3D world.

.

The Pad Definition dialog box appears.

8. Switch the type to Up to plane.

9. Select the plane on which the CD buttons
are placed to define the bottom limit of the pad
and click OK.

The PLACE_KEEPOUT area is displayed in
transparency.

The pad is more than a simple pad: it has technological properties.
10. Right-click the PLACE_KEEPOUT.1 in the specification tree to display the contextual
menu.
11. Select Properties.
The Properties dialog box opens.
12. Click the More... button.
13. Select the Circuit Board tab.

14. Enter 6mm in the Maximal height field and
2mm in the Minimal height field then click OK.
The pad is updated: the maximal and minimal height are linked to the pad limits.
It represents the overall dimensions of the constraint area.

Exporting Data (as IDF)
This task shows how to export data to an IDF file.

1. Click the Export icon
.
The Export dialog box opens.
2. Enter Export in the File name field.

3. Press Open.
An Information message is displayed:

Importing the IDF File
This task shows how to import the IDF data previously saved to a new document.
You can also import IDF data from an ECAD system.
You are in a new Product document.
1. Select File ->
Open in the menu
bar.
The File Selection
dialog box opens.

2. Select .idf in
the File of type
field.

3. Select the
Export.idf file.
4. Press Open.
If the file contains components, an Import dialog box opens.
5. Select the
library of interest.

6. Press Open.

The result should look like this:

Basic Tasks
The Basic Tasks section explains and illustrates how to create various kinds of
features.
The table below lists the information you will find.
Themes

Creating a Board
This section explains and illustrates different methods to create and/or modify
a board and its components.
The table below lists the information you will find.

From a Previously Created Part
This task shows how to create a board from an existing part.
Open the Scenario1.CATProduct document from the Samples/circuit board directory.
It contains a part with two pads.

1. Click the Board icon

.

The PartBody contains two pads, so you have to select the pad which will represent the board.
2. Select Pad.1.
CATIA recognizes the board and displays it in green.
You can add holes, pockets and constraint areas, as well as technological properties.

Automatic Recognition
in Circuit Board Workbench
This task illustrates how Circuit Board features are automatically recognized.
Open the Scenario2.CATProduct document from the Samples/circuit board directory.
It contains a part with a pad, holes and a pocket.

1. Click the Board icon
.
Since there is only one pad, it is recognized to be the board representation.
The objects (board and holes) have automatically acquired technological properties:

2. Select the Export icon
.
A board is recognized, all the related features are taken into account and exported
to the IDF file.
3. Open the .idf file as a text file. It looks like this:

Components Management
This section explains and illustrates different methods to create, use and/or
modify components.
The table below lists the information you will find.

Creating a Component
This task explains how to create and manage components.
Open the Component.CATProduct document from the
\online\samples\circuitboard directory.
The window looks like this:

1. Select the Component icon
.
The New Component dialog box
opens.

2. Enter comp1 in the Package number field.
3. Click OK to validate.
4. Select Pad.1 in the specification tree. This is the geometrical
representation of the new component.
The component is created.

Component Properties
This task explains how to browse the technological properties of a component.
Open the Scenario3.idf file and the corresponding Scenario3.lib file from the
\online\samples\circuitboard directory. An Assembly Product document is
generated.
1. Select the power jack PWJK (PW.1).
2. Using the right mouse button, open the Properties dialog box.
3. Click the More... button then select the Circuit Board Design tab.
The component is located on the Top face and its Status is Unplaced.
4. Change the Component location to Bottom and the Status to Placed.

CATIA projects the component onto the bottom board surface (in this case).
You can still move the component to the desired location on the surface of the
board.

5. Change the Status to Fixed
The FixTogether Constraint is created between the board and the power jack
PW.1.

Components and Constraints
This task explains how to manage components given the component constraint
type.
Open the Scenario3.idf file and the corresponding Scenario3.lib file from the
\online\samples\circuitboard directory. An Assembly Product document is
generated.

If the configuration you are using provides access to the Assembly workbench,
geometrical constraints are created between the board and the components, and
are displayed.
Within the assembly, the board need to be anchored.

1. Double-click the
power-jack
constraint shown
here in red.

The Constraint
Edition dialog box
opens.
The constraint type
is either Surface
Contact (placed
component) or Fix
Together (fixed
component).
The Assembly constraints (geometrical constraints) linking the components to
the board depend on the component status.
Component Status
Unplaced
Placed
Fixed

Assembly Constraint
No Constraint
Plane to Plane Constraint
Fixity Constraint

This information is transmitted through the import file (.idf), the component
capability to change location is then driven by the constraint.
Under certain circumstances, a component status can be modified:
from unplaced to placed or fixed
from placed to fixed
but never from fixed to placed or unplaced, nor from placed to unplaced (in order
to keep the information defined in the ECAD world).

Query From Catalog
This task explains how to insert a component resulting from a catalog query, in
a product.
Open a new Product document.

1. Click the Query from Catalog icon

.

The Catalog dialog box opens.
2. Select the catalog of interest and validate.

The Component chapter contents window is displayed.

3. Select a component, for example RES11
4. Copy it (Edit -> Copy or Ctrl+C)
5. Paste it (Edit -> Paste or Ctrl+V) in your document.
You can also display it using the Open button.

The component is now present in your Product document.

Working With Catalogs
This section explains and illustrates different methods to create and/or modify
the board and its components.
The table below lists the information you will find.

Creating a Catalog
This task explains how to create a catalog for circuit board components.
Open the Component2.CATProduct document from the
\online\samples\circuitboard directory.
The component is selected.
1. Select the Export a Component icon
.
The catalog doesn't exist, you are
prompted to create it.
2. Click Yes.
3. Enter a name for the catalog.

4. Validate.

A message informs you that the catalog has been created.

Note that you can store several components at the same time in the catalog.

Import with Catalog
This task explains how to import data, where the component 3D geometry is imported from a catalog.

1. Open the Import.idf document from the \online\samples\circuitboard directory.
The .idf file contains the location of the components in the circuit board assembly.
You can also use library and/or catalog to get a better geometry of the components:
the .lib file contains the 2D footprint geometry of the components.
the .catalog contains the 3D (exact) geometry of the components.
However, none of these files are mandatory.
You can choose between several alternatives:
open a library only: the 3D geometry is extruded from the 2D geometry
open a library and use an existing catalog:
the component exists in the catalog, its 3D geometry is imported from the catalog
the component does not exist in the catalog, it is extruded from the 2D geometry and stored in the
catalog
open a library and a new catalog: the 3D geometry is extruded from the 2D geometry and stored in the
newly created catalog
open no library, but a catalog:
the component exists in the catalog, its 3D geometry is imported from the catalog
the component does not exist in the catalog, it is created with no associated geometry
open no library and no catalog, the component has no associated geometry.

2. Select the ImportComps.lib file.
3. Check the box: Using a catalog

4. Click Open.
5. Select the catalog and validate.

Importing
See also Import with Catalog

Importing in Context
This task explains how to import circuit board elements and place them in
context.
Open the Context.CATProduct document from the \online\samples\circuitboard
directory.
1. Enter Circuit Board Design workbench.
A new part is created.

2. Select the Import in Context icon

.

3. Select the plane where you want to place the board and components, that is
to say the CD bottom plane.
The Import *.idf file dialog box is displayed.

4. Choose Scenario3.idf file, Scenario3.lib file and click Open.
The result should look like this:

Workbench Integration
This section explains and illustrates how to integrate other workbenches
The table below lists the information you will find.

Assembly
The integration with the Assembly Design workbench lets you to move
components on the board, provided you are allowed to do so by the
related constraint, in the context of the full digital product definition.
Refer to the Component Management section for more information.

ENOVIA-DMU Space Analysis
The strong integration with ENOVIA-DMU V5 Space Analysis allows you to complete the analysis of the
electronic assembly in the context of the full digital product definition.
Open the Scenario3.idf file and the corresponding Scenario3.lib file from the \online\samples\circuitboard
directory.
An Assembly Product document is generated.
Then add the existing component (BOTTOM).

1. Choose the DMU Space Analysis item from the Start menu.

2. Perform a Check Clash using this icon

The Preview window shows the clash:

.

The analysis reveals a clash. You can:
either, change the location of the component respecting the geometrical constraints
or create a mechanical constraint area taking the clash into account; then transmit the information to the
ECAD system in order to integrate it into the placing/routing algorithm.
For more information about DMU Space Analysis capabilities, refer to ENOVIA-DMU Space Analysis User's
Guide.

Workbench Description
The CATIA - Circuit Board Design Version 5 application window looks like this:
Click the hotspots to display the related documentation.

Menu Bar
Toolbar

Menu Bar
The Menu Bar and items which are available in CATIA - Circuit Board Design
workbench are the standard ones. The different commands and tools are
described in CATIA - Infrastructure Version 5.
For more information, refer to the CATIA Menu Bar section.

Circuit Board Toolbar
This section describes the various icons available in the Circuit Board Design
workbench.
The toolbar is located on the right in the default set-up.

See Creating a Board
See Creating a Constraint Area
See Exporting Data in an IDF File
See Import in Context
See Sketching a Profile
See Creating a Pad
See Creating a Pocket
See Creating a Hole
See Query from Catalog
See Creating a Component
See Creating a Catalog

Glossary
B
board
BOTTOM

A pad with technological properties
The technological property of a board face which makes it the
copper plated face

C
component
component
status

constraint area

cutout

An electronic part defined in the electronic schematic and stored in
the ECAD component library
Describes the position of a component on a board:
unplaced: there is no constraint between the component and the
board
placed: there is a surface contact between the component and the
board
fixed: there is a fixity constraint between the component and the
board
Dedicated geometrical constraints are also associated with
components and determine whether or not you can move them.
A space reservation used for different purposes such as
allowing/forbidding the routing or placing of components etc.
Each constraint area belongs to a part, this is to say that you need
to create a new part before creating a constraint area.
A hole or a pocket on a board

D
drilled hole

A hole used to mount a board in its case

E
ECAD

Electrical Computer Aided Design

F
fixed

See component status

I
IDF

Intermediate Data Format

N
NPTH

Non plated: technological property of a hole which is not conductive
(mounting hole)

O
other outline

Other area type defined by an outline, cutouts and a thickness

P
placed
place keepout
place outline
place region
PTH

See component status
A mechanical space reservation where the component height is
limited
An area where you are allowed to place components
An area where placing is limited to component of certain types
Plated: technological property of a hole which is conductive

R
route keepout
route outline

An area where routing of electrical connections is forbidden
An area where routing of electrical connections is allowed

S
status

See component status

T
TOP

The technological property of a board face which means it is not the
copper plated face

U
unplaced

See component status

V
via keepout

An area where placing via is forbidden

